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1 An overview of ELPLA-Section 

 

ELPLA-Section is used to display graphically the calculated results (settlements, contact 

pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) and 

input project data (additional settlements) at specified sections. The drawing of the results and 

data can be displayed first on the screen, and then can be sent to the printer or plotter. Also, all 

drawing sections can be exported to MS Excel. 

 

The calculated results and input project data can be presented graphically as follows: 

 

1 Section in x-direction 

2 Max./ Min. values in x-direction 

3 Overlapping in x-direction 

4 Section in y-direction 

5 Max./ Min. values in y-direction 

6 Overlapping in y-direction 

7 Arbitrary section 

 

The drawings, if desired, can be saved as WMF-Format files, in which they can be exported to 

other Windows applications such as Word and AutoCAD to prepare reports, slide presentations 

or add further information. 

 

 

2 Description of ELPLA-Section 

 

ELPLA-Section is a 32-bit analysis and design software product that operates under Microsoft 

Windows 9x/ NT/ ME/ XP. The common "what you see is what you get" of Windows 

applications makes it easy to learn how to use ELPLA-Section, especially if you are already 

familiar with the Windows environment. 

 

The program package ELPLA consists of 7 separate programs. The separate programs can be run 

independently. The name and short description of the programs are given in Table F-1. 

 

The usage of the program is typically such that first data files are created describing a certain 

problem by ELPLA-Data, then the project problem is analyzed by using ELPLA-Solver. Finally, 

the results can be presented as graphical drawing, graphs and tables using the five separate 

programs ELPLA-Graphic, ELPLA-Section, ELPLA-List, ELPLA-Boring and GEOTEC-Editor.  

 

In order to use ELPLA-Section, first the user must enter the project data by ELPLA-Data, and 

then must analyze the problem by ELPLA-Solver. Table F-2 gives a list of files, which are read 

or created by ELPLA-Section. The files can be classified in four groups. 
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Table F-1 Names and descriptions of the seven separate programs 

Program name                      Description of the program 

ELPLA-Data                     Editing project data 

ELPLA-Solver                         Analyzing the project problem 

ELPLA-Graphic                                Displaying data and results graphically 

ELPLA-List                                     Listing project data and calculated results 

ELPLA-Section                               Displaying results graphically at specified sections 

ELPLA-Boring                               Editing and displaying boring logs graphically 

GEOTEC-Editor                               A simple text editor program 

 

Table F-2 Names of file groups 

Group     Saved from the program  

A    Main data files                       ELPLA-Data 

B    Section files (*.SEC)              ELPLA-Section 

C    Project data files                      ELPLA-Data 

D    Final result files                           ELPLA-Solver 

 

Further more, Table F-3 shows filenames, contents and groups of all files that may be read or 

created by ELPLA-Section. 

 

Table F-3 Names and contents of files 

 

A Main data files 

Filename                         Contents  

FIRMA    Firm header 

STEU                        Default directory for files that are saved by ELPLA 

NOFORMAT             Number formats  

UNITS     System of units 

 

B Section files 

Filename           Contents 

PLOTPAR.SEC    Plot parameters 

LEGENDE.SEC    Legend data 

ORDINATE. SEC        Max. ordinate data 

LINEFORM.SEC         Line formats 

FONT.SEC                Font data 

 

C Project data files 

Filename    Contents 

*. AUF          3 line texts to identify the project 

*. BAU          Soil properties 

* .PO1            System data (calculation method) 

*. PL6            FE-Net data 

*. P33          Data of supports/ boundary conditions 

*. PV1         Data of additional soil settlements 
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D Final result files 

Filename  Contents 

*. PT3        Displacements due to temperature change (st) 

*. PP3        Settlements due to neighboring foundations (se) 

*. QUN      Ultimate bearing capacities at nodes (qul) 

*. PW1       Modulus of subgrade reaction (ks) 

*. PH1        Settlements (s) 

*. PH2        Contact pressures (q) 

*. PH3        Moments (mx) 

*. PH4        Moments (my) 

*. PH5        Moments (mxy) 

*. PH6        Shear forces (Qx) 

*. PH7        Shear forces (Qy) 

*. PH8        Settlements due to reloading (sw) 

*. PH9        Overburden pressures (Qu) 

*. H10      Support reactions (V) 

*. H11      Support reactions (My) 

*. H12      Support reactions (Mx) 

*. H13      Reinforcement of the slab  (Asx1) 

*. H14      Reinforcement of the slab  (Asx2) 

*. H15      Reinforcement of the slab  (Asy1) 

*. H16      Reinforcement of the slab  (Asy2) 

The asterisk (*) matches any filename with the specified extension. 

 

Next paragraphs describe the purpose and function of each ELPLA-Section command. 
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3 Starting ELPLA-Section 

 

Start ELPLA-Section by clicking on the program icon in the Windows "Start"-Menu. The 

introduction screen (Figure F-1) appears.  

 

 
Figure F-1 Introduction screen of ELPLA-Section 

 

The menu head of Figure F-1 contains the following seven commands: 

 

- File 

- View 

- Sections 

- Options 

- Format 

- Window 

- Help 

 

After clicking one of the seven menu commands, another sub-commands or options become 

available. The seven menu commands and their sub-commands are presented and described in 

the following paragraphs 4 to 11. 
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4 File Menu 

 

The File Menu commands are: 

 

- Open 

- Combination of many projects 

- Make WMF-File 

- Print 

- Page setup 

- Send to Excel 

- Files 1, 2, 3, 4 

- Exit 

 

4.1 File Menu–"Open" command 

 

By "Open" command the current project is closed, if one is loaded, and an existing project is 

opened. Figure F-2 shows "Open" Dialog box used to open a specified project.  

 

 
Figure F-2 "Open project" Dialog box 

 

4.2 File Menu–"Combination of many projects" command 

 

The extreme values of calculated results (settlements, contact pressures, deformation, internal 

forces, modulus of subgrade reaction and reinforcement) of many projects can be drawn. 

 

For determining results as extreme values or drawing results of many projects in a diagram, 

project names and their comments are required. 

 

When the command is chosen, the input Dialog box shown in Figure F-3 appears. In this input 

Dialog box the project name and its identification can be defined. 

 

4.3 File Menu–"Make WMF-File" command 

 

By "Make WMF-File" command the drawing can be saved in a format that can be read by other 

programs. This feature allows you to include your drawing in reports and presentations and to 

enhance the drawing using other drawing or CAD software packages. The drawing can be 

exported in the Windows Metafile (WMF) format. 
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Figure F-3 "Combination of many projects" input Dialog box 

 

4.4 File Menu–"Print" command 

 

By "Print" command data and results can be graphically plotted or printed. Only the objects 

currently displayed on the drawing are printed. Figure F-4 shows "Print" Dialog box. The printer 

group box contains controls for selecting the printer and changing its properties. Use "Name" 

Combo box to select the printer and use "Properties" Button to set printer settings. The number 

of printing copies can be defined in "Copies" Input box.  

 

 
Figure F-4 "Print" Input box 

 

4.5 File Menu–"Page setup" command 

 

By "Page setup" command the standard "Page setup" Dialog box can be displayed with options 

to specify the printer, page orientation, paper size and paper source, as well as other printing 

options. Figure F-5 shows "Page setup" Dialog box. 
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Figure F-5 "Page setup" Dialog box 

 

4.6 File Menu–"Send to Excel" command 

 

By this command, it is possible to export results as diagrams to MS Excel. 

 

4.7 File Menu–"Files 1, 2, 3, 4" command 

 

By "Files 1, 2, 3, 4" command the user can open one of the last four loaded projects. 

4.8 File Menu–"Exit" command 

 

By "Exit" command the current project is closed and ELPLA-Section is quitted (Figure F-7). 

 

 
Figure F-7 "Exit" Message box 

 

 

5 View Menu 

 

The View Menu commands are: 

 

- Status bar 

- Tool bars 
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5.1 View Menu–"Status bar" command 

 

"Status bar" command displays a status bar on the screen down. The status bar displays 

information about the progress of the current operation. 

 

5.2 View Menu–"Tool bars" command 

 

"Tool bars" command displays tool bars located just below the menu head. Tool bars contain 

icons of program menus. 

 

 

6 Sections Menu 

 

The Section menu is the main menu, which is used to display the specified drawing with the 

setting given by options, format and window menus. 

 

The Sections Menu commands are: 

 

- Section in x-direction 

- Max./ Min. values in x-direction 

- Overlapping in x-direction 

- Section in y-direction 

- Max./ Min. values in y-direction 

- Overlapping in y-direction 

- Arbitrary section 

 

 

 

 

 

6.1 Sections Menu–"Section in x-direction" command 

 

By "Section in x-direction" command the calculated results (settlements, contact pressures, 

deformation, internal forces, modulus of subgrade reaction and reinforcement) and input data 

(additional settlements) can be plotted at a specified section in x-direction.  

 

When this command is chosen, the selection Dialog box shown in Figure F-8 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 
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Figure F-8 "Section in x-direction" items 

 

For drawing results at a specified section in x-direction, ranges of the section are required as 

shown in Figure F-9. 

 

 
Figure F-9 "Section in x-direction" Dialog box 

 

As an example, Figure F-10 shows a specified section of settlement in x-direction. 
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Figure F-10 Section of settlement in x-direction 

 

6.2 Sections Menu–"Max./ Min. values in x-direction" command 

 

By "Max./ Min. values in x-direction" command the extreme values of results (settlements, 

contact pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) 

and input data (additional settlements) can be plotted at a specified range in x-direction. When 

the command is chosen, the selection Dialog box shown in Figure F-11 appears. In this Dialog 

box select one item to draw and then click "OK" Button.  

 

 
Figure F-11 "Max./ Min. values in x-direction" items 

 

For drawing extreme values of results at a specified range in x-direction, ranges of the section 

are required as shown in Figure F-12. 
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Figure F-12 "Section in x-direction" Dialog box 

 

As an example, Figure F-13 shows extreme values of moments mx in x-direction for the whole 

raft. 

 

 
Figure F-13 Extreme values of moments mx in x-direction for the whole raft 
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6.3 Sections Menu–"Overlapping in x-direction" command 

 

Values of calculated results (settlements, contact pressures, deformation, internal forces, 

modulus of subgrade reaction and reinforcement) and input data (additional settlements) can be 

plotted in many sections for a specified range in x-direction in one graph. 

 

When "Overlapping in x-direction" command is chosen, the selection Dialog box shown in 

Figure F-14 appears. In this Dialog box select one item to draw, then click "OK" Button.  

 

 
Figure F-14 "Overlapping in x-direction" items 

 

For drawing values of calculated results at a specified range in x-direction in one graph, ranges 

of the section are required as shown in Figure F-15. 

 

 
Figure F-15 "Overlapping in x-direction" Dialog box 

 

As an example, Figure F-16 shows values of shear forces Qy in x-direction in a specified zone of 

the raft. 
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Figure F-16 Sections of shear forces Qy in x-direction for a specified zone 

 

6.4 Sections Menu–"Section in y-direction" command 

 

By "Section in y-direction" command the calculated results (settlements, contact pressures, 

deformation, internal forces, modulus of subgrade reaction and reinforcement) and input data 

(additional settlements) can be plotted at a specified section in y-direction.  

 

When this command is chosen, the selection Dialog box shown in Figure F-17 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-17 "Section in y-direction" items 
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For drawing results at a specified section in y-direction, ranges of the section are required as 

shown in Figure F-18. 

 

 
Figure F-18 "Section in y-direction" Dialog box 

 

As an example, Figure F-19 shows a specified section of contact pressures in y-direction. 

 

 
Figure F-19 Section of contact pressures in y-direction 
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6.5 Sections Menu–"Max./ Min. values in y-direction" command 

 

By "Max./ Min. values in y-direction" command the extreme values of results (settlements, 

contact pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) 

and input data (additional settlements) can be plotted at a specified range in y-direction.  

 

When the command is chosen, the selection Dialog box shown in Figure F-20 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-20 "Max./ Min. values in y-direction" items 

 

For drawing extreme values of results at a specified range in y-direction, ranges of the section are 

required as shown in Figure F-21. 

 

 
Figure F-21 "Section in y-direction" Dialog box 

 

As an example, Figure F-22 shows the extreme values of moments my in y-direction for the 

whole raft. 
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Figure F-22 The extreme values of moments my in y-direction for the whole slab 

 

6.6 Sections Menu–"Overlapping in y-direction" command 

 

By "Overlapping in y-direction" command the values of calculated results (settlements, contact 

pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) and 

input data (additional settlements) can be plotted at a specified range in y-direction in one graph.  

 

When this command is chosen, the selection Dialog box shown in Figure F-23 appears. In this 

Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-23 "Overlapping in y-direction" items 
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For drawing values of calculated results at a specified range in y-direction in one graph, the 

ranges of the section required as shown in Figure F-24. 

 

 
Figure F-24 "Section in y-direction" Dialog box 

 

As an example, Figure F-25 shows values of shear forces Qx in y-direction in a specified zone of 

the raft. 

 

 
Figure F-25 Sections of shear forces Qx in y-direction 
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6.7 Sections Menu–"Arbitrary section" command 

 

By "Arbitrary section in x-direction" command the calculated results (settlements, contact 

pressures, deformation, internal forces, modulus of subgrade reaction and reinforcement) and 

input data (additional settlements) can be plotted at any arbitrary section.  

 

When "Arbitrary section" command is chosen, the selection Dialog box shown in Figure F-26 

appears. In this Dialog box select one item to draw, then click "OK" Button. 

 

 
Figure F-26 "Section in x-direction" items 

 

For drawing results at any arbitrary section, ranges of the section are required as shown in Figure 

F-27. 

 

 
Figure F-27 "Section in x-direction" Dialog box 

 

As an example, Figure F-28 shows an arbitrary section of settlement. 

 



 

 

ELPLA-Section 

 

 

F-22 

 
Figure F-28 Arbitrary section of settlement 

 

 

7 Options Menu 

 

The Options Menu has the following commands: 

 

- Plot parameters 

- Scale 

- Axes 

- Title 

- Page No. 

- Copy 

 

7.1 Options Menu–"Plot parameters" command 

 

Plot parameters may be set as default values by the program, or be fully specified by the user. 

The following plot parameters can be specified (Figure F-29):   

 

- Display grid 

- Page with or without frame 

- Display values on lines 

- Display marks on lines 
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Figure F-29 "Plot parameters" Dialog box 

 

7.2 Options Menu–"Scale" command 

 

By "Scale" command the scale factor of the drawing can be defined as shown in Figure F-30. 

The defaulted value for the scale factor is chosen to pass the active printer-paper format. 

 

 
Figure F-30 "Scale" Dialog box 

 

7.3 Options Menu–"Axes" command 

 

By "Axes" command scaled axes can be defined on the drawing, Figure F-31. 

 

 
Figure F-31 "Axes" Dialog box 

 

7.4 Options Menu–"Title" command 

 

By "Title" command the text data (two line texts above the drawing and two line texts under the 

drawing) can be defined, Figure F-32. Default texts are: 

 

- A-Title1:      Method No. 

- A-Title2:      Name of method 

- U-Title1:      Name of drawing 

- U-Title2:      Ranges that define the section 
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Figure F-32 "Title" Dialog box 

 

7.5 Options Menu–"Page No." command 

 

By "Page No." command the page No. can be defined, Figure F-33.  

 

 
Figure F-33 "Page No." Dialog box 

 

7.6 Options Menu–"Copy" command 

 

By "Copy" command the current drawing can be copied in Metafile-Format to Clipboard. Then it 

can be inserted directly to another Windows programs such as Word, WordPerfect and 

AutoCAD. 

 

 

8 Format Menu 

 

The Format menu has the following commands: 

 

- Line formats  

- Max. ordinate 

- Font 

- Legend 

 

8.1 Format Menu–"Line formats" command 

 

Color, style and thickness of drawing lines can be defined, Figure F-34. The way a line is drawn 

depends on the setting of the color and style properties. There are available 15 different colors 

and 5 styles for line formats. 
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The following list shows the available lines, which can be formatted: 

 

- Grid 

- Page boundary 

- Identification box 

- Axes 

- Location of the section 

- Sections 

 

Note: The asterisk (*) matches drawing section number. 

 

 
Figure F-34 "Line formats" Dialog box 

 

8.2 Options Menu–"Max. ordinate" command 

 

By "Max. ordinate" command the maximum ordinate of the vertical axis and the maximum size 

of markers can be defined in [mm], Figure F-35. 

 

 
Figure F-35 "Max. ordinate" Dialog box 

 

8.3 Format Menu–"Font" command 

 

By "Font" command font size (Figure F-36) and font type (Figure F-37) for the drawing can be 

defined. 
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Figure F-36 "Font size" Dialog box 

 

 
Figure F-37 "Font" Dialog box 

 

8.4 Format Menu–"Legend" command 

 

By "Legend" command the height and width of legends (Identification box, symbol and location 

of the section) can be specified as shown in Figure F-38. 

 

Display legend 

In "Display legend" Group box check the legend that you wish to display. 

 

Legend size 

In "Legend size" Group box the height and width of the legend can be defined.  

 

 
Figure F-38 "Legend" Dialog box 
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9 Window Menu 

 

The Window menu has the following commands: 

 

- Zoom in 

- Zoom out  

- Zoom window  

- Zoom % 

- Original size 

 

9.1 Window Menu–"Zoom in" command 

 

By "Zoom in" command the size of the drawing on the screen can be reduced. 

 

9.2 Window Menu–"Zoom out" command 

 

By "Zoom out" command the size of the drawing on the screen can be increased. 

 

9.3 Window Menu–"Zoom window" command 

 

By "Zoom window" command the size of the drawing on a specified area can be increased. 

 

9.4 Window Menu–"Zoom %" command 

 

When you choose "Zoom %" command, the following Dialog box appears, Figure F-39. 

 

 
Figure F-39 "Zoom %" Dialog box 

 

By "Zoom %" command the size of drawings on the screen can be specified. Choosing "Zoom 

%" allows you to increase or decrease the size at which the drawing is displayed. Choosing 

100% displays the drawing at its original size. Clicking on the percentage, changes the drawing 

size to the specified percentage. The drawing can be displayed at any size by typing the desired 

percentage in the specified Edit box. 

 

9.5 Window Menu–"Original size" command 

 

The commands "Zoom in", "Zoom out" and "Zoom %" can change the size of drawing on the 

screen. The drawing can be displayed in its original size again using "Original size" command. 
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10 Help Menu 

 

The Help Menu commands are: 

 

- Contents 

- Short description of ELPLA 

- New in ELPLA 

- About ELPLA-Section 

 

10.1 Help Menu–"Contents" command 

 

"Contents" command displays a help file in HTML-Format containing the complete ELPLA 

User’s Guide, Figure F-40. 

 

 
Figure F-40 Menu "Contents" 

 

10.2 Help Menu–"Short description of ELPLA" command 

 

"Short description of ELPLA" command gives a short description of ELPLA package. 

 

10.3 Help Menu–"New in ELPLA" command 

 

"New in ELPLA" command summarizes the new features and enhancements in ELPLA. 
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10.4 Help Menu–"About ELPLA-Section" command 

 

Clicking the command "About ELPLA-Section" displays the information form of ELPLA-

Section as shown in Figure F-41 This gives information about ELPLA-Section and the 

calculation method of the loaded project. 

 

 
Figure F-41 Information form of ELPLA-Section 

 

 

11 Tips and Tricks 

11.1 Keyboard 

 

The user can obtain all menu titles and commands also through Shortcut keys. The action of the 

Shortcut keys is listed in Table F-4 to Table F-11: 

 

Table F-4 Shortcut keys of menu head 

Shortcut keys Action 

[Alt+f] Calling menu head  "File" 

[Alt+v]    "View" 

[Alt+s]     "Sections" 

[Alt+o]     "Options" 

[Alt+t]     "Format" 

[Alt+w]     "Window" 

[Alt+h]     "Help" 
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Table F-5 Shortcut keys of File-Command 

Shortcut keys Action 

[Ctrl +o] or [Alt+f] then [o]  Calling command  "Open" 

[Alt+f] then [c]    "Combination of many projects" 

[Alt+f] then [w]    "Make WMF-File" 

[Ctrl +p] or [Alt+f] then [p]    "Print" 

[Alt+f] then [u]    "Page setup" 

[Alt+f] then [s]    "Send to Excel" 

[Alt+f] then [1] Calling the first project from the last four loaded projects 

[Alt+f] then [2]  Calling the second project from the last four loaded projects 

[Alt+f] then [3]  Calling the third project from the last four loaded projects 

[Alt+f] then [4]  Calling the fourth project from the last four loaded projects 

[Ctrl+q] or [Alt+f] then [x]  Calling command "Exit" 

 

Table F-6 Shortcut keys of View-Command 

Shortcut keys Action 

[Alt+v] then [b]  Calling command  "Status bar" 

[Alt+v] then [t]     "Tool bars" 

[Alt+v] then [t], then [f]    "Tool bars-File" 

[Alt+v] then [t], then [s]    "Tool bars-Sections" 

[Alt+v] then [t], then [o]    "Tool bars-Options" 

[Alt+v] then [t], then [t]    "Tool bars-Format" 

[Alt+v] then [t], then [w]    "Tool bars-Window" 

[Alt+v] then [t], then [h]    "Tool bars-Help" 

[Alt+v] then [t], then [r]    "Reset Toolbar" 
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Table F-7 Shortcut keys of Sections-Command  

Shortcut keys Action 

[Alt+s] then [x]  Calling command  "Section in x-direction" 

[Alt+s] then [m]     "Max./ Min. values in x-direction" 

[Alt+s] then [o]    "Overlapping in x-direction" 

[Alt+s] then [y]    "Section in y-direction" 

[Alt+s] then [a]    "Max./ Min. values in y-direction" 

[Alt+s] then [r]    "Overlapping in y-direction" 

[Alt+s] then [a]    "Arbitrary section" 

 

Table F-8 Shortcut keys of Options-Command 

Shortcut keys  Action 

[Alt+o] then [l]  Calling command  "Plot parameters" 

[Alt+o] then [s]     "Scale" 

[Alt+o] then [a]     "Axes" 

[Alt+o] then [t]     "Title" 

[Alt+o] then [p]     "Page No." 

[Alt+o] then [c]     "Copy" 

 

Table F-9 Shortcut keys of Format-Command 

Shortcut keys  Action 

[Alt+t] then [l]  Calling command  "Line formats" 

[Alt+o] then [x]     "Max. ordinate" 

[Alt+t] then [f]     "Font" 

[Alt+t] then [d]     "Legend" 

 

Table F-10 Shortcut keys of Window-Command 

Shortcut keys  Action 

[Alt+w] then [i]  Calling command  "Zoom in" 

[Alt+w] then [o]     "Zoom out" 

[Alt+w] then [w]     "Zoom window" 

[Alt+w] then [z]     "Zoom %" 

[Alt+w] then [r]     "Original size" 
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Table F-11 Shortcut keys of Help-Command 

Shortcut keys  Action 

[Alt+h] then [c]  Calling command  "Contents" 

[Alt+h] then [s]    "Short description of ELPLA" 

[Alt+h] then [n]    "New in ELPLA" 

[Alt+h] then [a]     "About ELPLA-Section" 

 

11.2 Mouse 

 

By double-clicking the left mouse Button on a specified screen position, the user can obtain 

almost menus of the program. 

 

- By double-clicking on Legend, Firm header, Title or Project identification, the 

corresponding menu appears 

 

- By double-clicking on Scale in the identification box, "Scale"-Menu appears 

 

- By double-clicking on File name in the identification box, "Open"-Menu appears 

 

- By double-clicking on Page No. in the identification box, "Page No."-Menu appears 

 

- By clicking the right mouse Button at any position on the screen, the user can also obtain 

the Popup- Options-Menu, Figure F-42 

 

 

 
Figure F-42 Menu "Popup- Options" 
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12 Samples for graphical drawings using ELPLA-Section 

 

ELPLA-Section gives the ability to present many different graphical drawings for results. In this 

paragraph the graphical drawings for results of example problem gb7, an irregular raft on 

irregular subsoil, is presented. 

 

The pages P1 to P3 show some graphical presentations of example gb7 in different possibilities 

according to Table F-12. There is also a great number of presentation possibilities that are not 

consider in this paragraph. Color presentation is also possible by ELPLA-Section. 

 

Table F-12 Graphical drawings for results 
 
Presentation       Page 

Contact pressure q                                             P1 

Max./ Min. values of moments mx                                      P2 

Overlapping of 3 Sections of shear forces Qy   P3 
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Short description ..................................................... 28, 32 
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Status bar ...................................................................... 11 
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Title......................................................................... 22, 23 
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